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A. General 
 
1.   Forms are used for the collection, transmittal, and preservation of information. 
 
2.   Forms serve as a compact, concise record of information, that when standardized, promote an 
efficient operation. 
 
3.   Many NRP policies, procedures, and functions are documented through Agency forms. 
 
B. Authority 
 
1.   The forms control program is administered by the NRP Planning, Records, & Warrants Section. 
 
2.   The Planning, Records, & Warrants Section is designated by the Superintendent to administer the 
program. 
 
C. Forms Control Program 
 
1. A forms control program will ensure the need for and standardization of NRP forms. 
 
2. The objective of the forms control program is to control the creation of new forms, to revise or 
consolidate existing forms, and to eliminate non-essential or duplicate forms. 
 
3. The Planning Section will do the following: 

a. Establish and maintain a forms control register that contains control numbers, effective dates, 
form titles and revision dates of all forms. 

b. Approve form design and use. 
c. Issue form numbers. 
d. Establish effective and revision dates. 
e. Authorize printing. 
f. Maintain a master forms file. 
g. Maintain a historical file on revised forms.  
h. Maintain a current inventory of active forms on NRP’s server for access by officers at area 

offices. 
i. Consult with users create, revise, combine or eliminate forms when necessary. 

 
2.   Forms Committee 

a. The Commander of the Communications & Strategic Planning Division shall serve as the 
chairperson. 

b. The Superintendent shall appoint other members that will include the Adjutant to the 
Superintendent, Communication Center/Planning/Records Unit Commander, and Supervisor of 
the Planning, Records, and Warrants Section, a supervisor from each Field Operations Bureau 
and Special Services Bureau and other personnel as needed.  The committee shall convene twice 
a year to create, revise, combine, or eliminate forms.   

 
D. Forms 
 
1.   Forms originating from the NRP will be assigned a form number and effective date. 
 
2.   The designation “NRP-” will precede the form number.  The form number and implementation or 
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revision date will appear in the lower left corner of each form.  For example form 123 would appear as 
“NRP-123 (Rev. 10/04)” in the lower left corner of the form. 
 
3.   When a unit creates a form to record information unique to its operation, a draft of the proposed 
form will be submitted through the chain of command to the Planning, Records, & Warrants Section.  
 
4.   The Planning, Records, & Warrants Section will assign a number to the approved form. 
 
5.   Only the most current forms may be utilized. 
 
6.   Forms may not be altered in any manner. 
 
E. Creating, Revising, Combining or Eliminating Forms 
 
1.   Forms that cease to serve their designated purpose should be revised, combined with an existing 
form, or eliminated. 
 
2.   NRP employees who think a form should be created, revised, combined, or eliminated, will make the 
request via memorandum through the chain of command to the Planning, Records, & Warrants Section. 
 
3.   The memorandum will state the reasons for the requested action.  A sample of the proposed form 
should be attached, if applicable. 
 
4.   Appropriate endorsements will be made to the report concerning the proposed change at each level 
of command.  This review process encourages input from each staff member resulting in a product 
reflecting the experience and knowledge of everyone responding. 
 
F. Form Numbering System 
 
1.   Forms shall be numbered as follows: 
 

 

# Series Description 
100 Submitted Weekly 
200 Submitted Bi-Weekly 
300 Submitted Monthly 
400 Submitted As Needed 
500 Submitted As Needed 
600 Emergency Operations Forms 
700 Training Forms 
800 Internal & Disciplinary Forms 
900 Personnel Appraisal Forms 

RMS Records Management System Forms 
 
G. Utilization of NRP Forms with Microsoft Word Protected Form Fields 
 
1.   A number of NRP Forms have been designed with form fields (grayed boxes) which allow the user 
to move within the form and easily complete the form in a standardized format. 
 

a. As the cursor is moved into each form field, the user will notice in the lower left-hand corner that 
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a message is displayed describing the data that is needed in the field.  This is designed to assist 
the user in completing the form properly. 

 

b. On some forms, as the cursor is moved from one field to another, a pop-up box will be displayed 
describing instructions for Spell Checking and Protecting-Unprotecting the document. 

 
c. To “Protect-Unprotect” a document follow the procedures below. 

 
(1) Click on the “Protect-Unprotect Form” button on the toolbar which is located at the top of the 

Microsoft Word document menu.  This will Unprotect the document. 
 

(2) Enter or modify the information as necessary. 
 

(3) Once necessary information has been entered the user must re-protect the document by 
clicking on the “Protect-Unprotect Form” button on the toolbar which is located at the top of 
the Microsoft Word document menu.  This will Protect the document. 

 
(4) Whenever a “Protect Document” box is displayed, the user must always select “Protect 

document for” - “Forms.” 
 

d. There is a limitation in utilizing Microsoft Form Fields; and that is, certain formatting functions, 
such as bolding and underlining, will not work within a form field.  Should personnel wish to 
utilize bolding or underlining in their narrative text, then they must perform the following: 
(1) Unprotect the document. 
(2) Delete the form field where they wish to type their narrative, including the bolded or 

underlined text. 
(3) Upon completion of typing the narrative text, Protect the document.  (Remember to Protect 

the document for “Forms.” 
 
2.   Before a user can utilize NRP Forms that were designed with form fields, a change must be made to 
Microsoft Word. 
 

a. Changes to Microsoft Word 2000 Settings: 
(1) Go to the Word toolbar and click on “Tools.” 
(2) Wait until the “Tools” drop-down menu expands and click on “Macro.” 
(3) On the “Macro” drop-down menu click on “Security.” 
(4) When the “Security” menu opens, click on “Security Level” and set the macro security level 

to “Low.” 
(5) Close Microsoft Word and then restart it to set the new macro security level. 

 
b. Changes to Microsoft Word 2010 or Word 2016 Settings: 

(1) Click the File tab. 
(2) Click Options. 
(3) Click Trust Center, and then click Trust Center Settings. 
(4) In the Trust Center, click Macro Settings. 
(5) Click on Enable all macros. 
(6) Click OK. 
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H. Utilization of NRP Forms with Microsoft Word Protected Headers or Footers 
 
1.   A number of NRP Forms have been designed with protected headers and/or footer.  These protected 
headers and/or footers allow the same information to be printed on all subsequent pages. 
 
2.   To access a protected header and/or footer and complete the necessary information, click on the 
“Protect-Unprotect Form” button on the toolbar which is located at the top of the Microsoft Word 
document menu.  This will Unprotect the document. 
 
3.   Once he document has been unprotected, complete the necessary information in the header and/or 
footer and then click on the “Protect-Unprotect Form” button again to protect the document. 
 
4.   Whenever a “Protect Document” box is displayed, the user must always select “Protect document 
for” - “Forms.” 
 
I. Utilization of NRP Forms with Excel Spreadsheets 
 
1.   A number of NRP Forms have been designed as an Excel spreadsheet or as a Word document with a 
spreadsheet incorporated into the document.  Some of these spreadsheets contain items such as check-
boxes, which require a change to Microsoft Excel for the form to function properly. 
 

a. Changes to Microsoft Excel 2000 Settings: 
(1) Go to the Excel toolbar and click on “Tools.” 
(2) Wait until the “Tools” drop-down menu expands and click on “Macro.” 
(3) On the “Macro” drop-down menu click on “Security.” 
(4) When the “Security” menu opens, click on “Security Level” and set the macro security level 

to “Low.” 
(5) Close Microsoft Excel and then restart it to set the new macro security level. 

 
b. Changes to Microsoft Excel 2010 or Excel 2016 Settings: 

(1) Click the File tab. 
(2) Click Options. 
(3) Click Trust Center, and then click Trust Center Settings. 
(4) In the Trust Center, click Macro Settings. 
(5) Click on Enable all macros. 
(6) Click OK. 

 
J. The Use of Google Forms  
 
1.   Google forms may be created as needed to gather information or statistics.  
 
K. Status Definitions 
 
For those NRP forms that require notification of incident status, the following definitions shall apply. 
 
1.   Closed – Indicates that the investigation is complete and no further active investigation is required.  
Incidents can be closed under the following conditions: (discussion on when to close report) 

a. Apprehension of the perpetrator. 
b. Incidents of stolen property can be closed when: 

(a) All property is recovered and accounted for; and, 
(b) When all investigatory have been exhausted. 
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c. Incidents of abandoned, lost, or seized property can be closed when: 
(1) When property has been confiscated or forfeited by court action; or  
(2) When property has been held for 6 months and the owner of the property cannot be 

determined.  (See §1-2A-01 of the Natural Resources Article) 
d. All other incidents can be closed when the investigation reveals that no further action can be 

taken, and the incident receives proper approval. 
 
2.   Pending Further Information (open with active warrant, pending further information, warrant 
request approved) – Indicates that an incident is being actively investigated, and it does not meet the 
criteria for Closed. 
 
3.   Follow-Up Patrol (open, open pending destruction of property, open pending return of property, 
open LEIN entry only, other enforcement action, pending laboratory analysis, review for closure, 
warrant request approved, warrant request submitted) 
 
L. Original Signatures Required 
 
1.   Certain NRP forms require original inked signatures as specified on the forms.  These forms include, 
but are not limited to, most forms in the 800 series.    
 
2.   The only exception to this rule on original signatures would be if the form’s instruction sheet 
specifically notes that an original signature is not required or that a computerized signature is acceptable. 
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A. RMS Reports Replacing NRP Forms 
 

The following table lists those reports that are part of the CAD/RMS programs, and the NRP forms 
that the CAD/RMS programs replace.  Except where noted, paper versions of the obsolete NRP 
forms are no longer acceptable.  The affected forms include the following: 

 

Obsolete NRP Forms &  
Replacement CAD Entries / RMS Reports 

Old NRP 
Form 

Number 
Old NRP 

Form Name Replacement CAD Entry / RMS Report 

NRP-206 Employee Work Report Officer’s Daily Log 

NRP-301 Commercial Waterman & Aquaculture 
Harvester Inspection Report 

Since the NRP-301 is now obsolete officers will enter the 
information into the CAD program to capture the inspections under 
“Inspection of Commercial Fisheries Establishments, Vehicles, & 
Vessels.” 

NRP-303 Report on Patrol of Closed Shellfish Area Information now captured in Officer’s Daily Log. 
NRP-403 Hunting Accident Report RMS Hunting Related Accident Template 
NRP-403A Hunting Accident Report – Short Form Hunting Related Accident Investigation – Short Form 
NRP-409 Investigative Report RMS Incident Report 

NRP-410 Supplemental Investigative Report 

RMS Supplement Report 
 

Comments 
 

The NRP-410 will be only used to complete a supplemental report 
for incidents that were entered into the CAD system prior to 
October 8, 2013. 

NRP-410A Incident Property List Part of RMS Incident Report 

NRP-412 Watercraft Accident Report 

RMS Watercraft Related Accident Template 
 

Comments 
 

The NRP-412 will still be utilized by law enforcement agencies 
outside of NRP to document boating related accidents within the 
state. 

NRP-416 Property Inventory Record Part of RMS Incident Report 
NRP-419 Abandoned Boat Report RMS Abandoned Boat Report Template 
NRP-430 Alcohol Influence Report RMS Alcohol Influence Report Template 

NRP-445 Notification of Federal / Criminal Charges 

Part of RMS Incident Report 
 

Comments 
 

Offenses should ONLY be entered into RMS for the following 
violations: 
 

A. Criminal Violations  
 1. On view arrest 
 2. Application for statement of charges (warrant or criminal 
summons)  
 3. Criminal citations 
 

B. Natural Resources Violations 
 1. Instances where an officer prepares an application for 
statement of charges for DNR violations. 

NRP-461 Property Transfer-Disposal Request RMS Property Transfer-Disposal Request Template 
NRP-488 Debris Removal Report RMS Debris Removal Report Template 
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A.  NRP Forms  
 
1.   The NRP Forms  are listed on the NRP Computer Network and can be found at the following hyperlink: 
 

\\Tawesdata2\nrp\Common\NRP_Forms 
 
2.   Effective 05/01/2011 forms will no longer be printed in the Manual, but will be readily available on the 
NRP Computer Network. 
 
3.   Generally, only those forms that are investigative in nature, or enforcement related compliance checks may 
be scanned into the RMS program (i.e., wildlife compliance checks).   
 
4.   In general, forms that relate to non-investigative matters should not be scanned into the RMS program.  
Such forms include, but are not limited to, the following: 

a. Administrative related forms 
b. Personnel related forms 
c. Applicant related forms 
d.  Internal Investigation forms 
e. Disciplinary related forms 
f. Inspection related forms (i.e., equipment inspections, personnel inspections.) 
g. Training related form 
h. Departmental accident forms 
i. First report of injury 
j. Other non-investigatory patrol related forms 

 
5.   Personnel are directed to check the NRP Computer Network for the most up-to-date form and/or 
instructions. 
 
6.   Note: Only when considered necessary for accurate form completion are form instructions given. 
 

file://Tawesdata2/nrp/Common/NRP_Forms
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